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Getting Started

 

elcome to the Adobe

 

®

 

 Type Manager

 

®

 

 
(ATM

 

®

 

) Deluxe 4.1 utility for 
Microsoft

 

®

 

 Windows

 

®

 

. ATM Deluxe is 
a tool for managing, printing, and displaying 
PostScript

 

®

 

 Type 1 fonts. ATM Deluxe lets you 
display PostScript fonts on-screen and print 
PostScript fonts on non-PostScript printers. You 
can use ATM Deluxe to add, remove, and organize 
PostScript and TrueType fonts. 

 

The ATM Deluxe CD contents

 

The ATM Deluxe CD includes the following 
applications and files:

 

•

 

The ATM Deluxe installer

 

•

 

Adobe Type Library fonts

 

•

 

Adobe Acrobat

 

®

 

 Reader

 

•

 

Technical documents

 

•

 

Adobe PostScript printer driver

 

Installing ATM Deluxe

 

The ATM Deluxe installer program adds the ATM 
Deluxe software to your hard disk. For system 
requirements and detailed information on instal-
lation, application compatibility, and printer 
compatibility, see the ATM Deluxe Read Me file on 
the CD.

 

Starting ATM Deluxe

 

By default, ATM Deluxe runs invisibly on your 
system to display PostScript fonts. However, to 
install and remove fonts and perform other font 
management tasks, you need to start ATM Deluxe.

The first time you start ATM Deluxe, a welcome 
message explains that ATM Deluxe has added 
installed PostScript and TrueType fonts to a set 
called Starter Set. You can rename, modify, or 
remove this set at any time to suit your font 
management scheme. For more information, 
see “About sets” on page 3.

 

To start ATM Deluxe:

 

Choose Start > Programs > Adobe > Adobe Type 
Manager > Adobe Type Manager Deluxe 4.1. 

 

Registering ATM Deluxe

 

Registering your software helps Adobe offer 
technical support and inform you about new 
software developments. Please register your 
copy by filling out and returning the warranty 
registration card included with your software 
package.

 

Learning ATM Deluxe

 

This guide will help you use ATM Deluxe on two 
Windows platforms:

W
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•

 

Windows 95, Windows 98, or later (Windows 
95, Windows 98, and successor products)

 

•

 

Windows NT

 

®

 

 4.0 and Windows 2000 
Professional

For information on using fonts with applications, 
and for additional tips and troubleshooting infor-
mation, see the ATM Deluxe Read Me file included 
with the software.

This guide assumes you have a working knowledge 
of your computer and its operating system. Infor-
mation in this guide is available in online Help.

 

To get online Help:

 

Choose Help > Help Topics.

 

Removing ATM Deluxe

 

You can remove the ATM Deluxe program from 
your system easily. Uninstalling ATM Deluxe does 
not delete any font files from your system, but it 
may prevent fonts from displaying and printing 
properly. If you want to remove fonts from your 
hard disk, you should remove them using ATM 
Deluxe before uninstalling ATM Deluxe. For more 
information, see “Removing fonts” on page 7.

 

Note:

 

 Windows 2000 Professional ships with the 
ATM font driver, which runs in the background to 
display PostScript fonts. On other Windows 
platforms, you install the font driver (and the other 
ATM Deluxe component, the font manager) when 
you install ATM Deluxe. In Windows 2000 Profes-
sional, uninstalling ATM Deluxe removes only the 
font manager, not the font driver.

 

To remove ATM Deluxe:

 

1

 

In Windows, choose Start > Programs > 
Adobe > Adobe Type Manager > Uninstall Adobe 
Type Manager Deluxe 4.1.

 

2

 

Click Yes to confirm the removal of ATM Deluxe 
from your hard disk.

 

Using the Adobe home page

 

If you have an Internet connection and a Web 
browser installed on your system, you can access 
the Adobe Systems home page on the World Wide 
Web (at http://www.adobe.com) for information 
and tips on Adobe products and services. From the 
Adobe Web site, you can purchase and download 
fonts and certain other Adobe products.

For more information about Adobe technical 
support resources, see the notice in your software 
package.
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Chapter 1: Managing Fonts

 

dobe Type Manager Deluxe is the only 
program you need to add, remove, and 
organize your fonts. In addition, ATM 

Deluxe lets you see what a font looks like before 
you add it to your system. 

 

About sets

 

ATM Deluxe lets you organize your fonts into 
groups known as 

 

sets

 

. When you create a set, you 
are not actually moving font files; instead you are 
grouping representations of those files (similar to 
Windows shortcuts) into arrangements that work 
best for you. That means a single font can appear 
in several sets without duplicate font files taking 
up hard disk space.

In addition, you can improve the performance of 
Windows and your Windows applications by 
turning off or deactivating entire sets or individual 
fonts you don’t need. Deactivating sets or fonts 
removes fonts from the font menus and lists in 
your applications but does not remove font files 
from your hard disk. For more information, see 
“Activating and deactivating fonts and sets” on 
page 8.

 

Viewing sets

 

In ATM Deluxe, sets appear as folder icons. You 
can show or hide the fonts in each set, and view the 
different sets to which a font has been assigned.

 

To view the fonts in a set:

 

1

 

In ATM Deluxe, click the Sets tab. 

 

2

 

Double-click a closed folder icon to display the 
fonts in that set.

 

You can also view sets in the Destination list of 
the Add Fonts tab. To see sets in the Source list, 

choose Add from Font Sets from the Source list.

 

To hide the fonts in a set or all sets:

 

1

 

In ATM Deluxe, click the Sets tab.

 

2

 

Double-click an open folder icon to hide the 
fonts in that set, or choose Display > Close All 
Open Sets to hide fonts in all sets.

 

To hide the fonts in all sets in the Add Fonts tab, 
choose Set > Close All Open Sets.

A
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Managing Fonts

 

To view which sets a font belongs to:

 

1

 

In ATM Deluxe, click any tab that shows 
individual fonts.

 

2

 

Right-click any font and choose Properties. 
Note the sets (if any) listed for the font.

 

Previewing fonts

 

Before you add a font to a set, you may want to see 
what it looks like. You can preview a font in ATM 
Deluxe. For information on changing the sample 
text and printing sample sheets, see “Customizing 
and printing sample sheets” on page 18.

You cannot preview two special fonts installed 
with ATM for Windows 95, Windows 98, or later: 
AdobeSanMM and AdobeSerMM. These multiple 
master fonts are used for font substitution. For 
more information about font substitution, see 
“Customizing font handling” on page 20.

 

To preview a font with ATM Deluxe:

 

1

 

In ATM Deluxe, click any tab that shows 
individual fonts.

 

Note: 

 

You cannot preview a font in an export set. For 
more information, see “Exporting sets” on page 10.

 

2

 

Do one of the following:

 

•

 

Double-click a font name to preview a 
single font.

 

•

 

Select up to 30 fonts. Right-click one font in the 
selection and choose Show Sample.
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When you are finished previewing the font, 
choose Sample > Close, or Sample > Close All to 
close sample windows. In the Sets or Font List tabs, 
you can also choose Display > Close All Sample 
Windows.

 

You can also preview a PostScript font by 
double-clicking a font file (any file with the 

extension .pfm or .pfb) in Windows Explorer or 
another file utility. This starts ATM Deluxe and 
opens the font sample window for the font file you 
double-clicked.

 

Creating sets

 

You’ll get more out of ATM Deluxe if you organize 
your fonts into useful sets. For example, you might 
group fonts by project, by name, or by function 
(display fonts, body text fonts, symbol fonts) and 
turn on as many sets as you need for your current 
work. If multiple users use the same computer, you 
could create sets for each user. 

A set that contains a multiple master instance 
(either a primary instance or a custom instance) 
always contains the base font for that instance. 
This also holds true for multiple master instances 
added outside any set. ATM Deluxe automatically 
adds the multiple master base font as needed when 
you add an instance to a set or outside any set. For 
information on these terms, see “About multiple 
master font designs” on page 13.

 

To create a set:

 

1

 

In ATM Deluxe, click the Add Fonts tab. 

 

2

 

If you want your new set to be active as soon as 
you create it, select the check box next to [New 
Set]. For additional information on active and 
inactive sets, see “Activating and deactivating fonts 
and sets” on page 8.

 

3

 

Choose Set > New or double-click [New Set] in 
the Destination list.

 

4

 

Type a name for the set and click OK. To add 
fonts to this set or to create a set and add fonts in a 
single step, see the next section.

 

Adding fonts

 

With ATM Deluxe, the steps for installing new 
fonts from a floppy disk or CD are the same 
as adding existing fonts to a set. The only 
difference is the source you select from which 
to add the fonts. 

For trouble-free use of PostScript and TrueType 
fonts, use ATM Deluxe to add and remove fonts.

 

Note:

 

 Adobe Type 1 outline fonts are licensed on a 
per-computer basis. If you use fonts on a network, be 
sure you’re licensed for the number of computers 
using the fonts. Contact Adobe at 800-682-3623 for 
details on site licensing.
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To add a font:

 

1

 

In ATM Deluxe, click the Add Fonts tab.

 

2

 

Using the Source list on the right, specify a 
source for the fonts you want to add:

 

•

 

Choose Browse for Fonts to add fonts from a 
local hard disk, CD, floppy disk, or network 
drive. Locate the folder that contains the font files 
you want.

 

•

 

Choose Create Multiple Master to add instances 
of multiple master fonts already installed on your 
system. For more information, see Chapter 
2, “Using Multiple Master Fonts.”

 

•

 

Choose Add from Font Sets to add fonts from 
font sets on your system.

 

•

 

Choose Add from Master Font List to add fonts 
from those on your system.

 

3

 

Select the fonts you want to add from the 
Source list.

 

4

 

If you chose Browse for Fonts in step 2 and want 
to add fonts without copying any font files to your 
hard disk, select Add without Copying Files. This 
is useful if you use fonts directly from a CD or 
network drive. If a network drive goes off line, or if 
you do not have the correct CD available, fonts 
remain installed, but the fonts may not display or 
print correctly.

 

Note: 

 

ATM Deluxe for Windows 95, Windows 98, or 
later substitutes other fonts for the missing fonts if 
Enable Font Substitution is selected in the Advanced 
Settings dialog box. For more information, see 
“Customizing font handling” on page 20.

 

5

 

Do one of the following:

 

•

 

Drag and drop the selected fonts on a set, [New 
Set], or outside any set in the Destination list. For 
a new set, type a name and click OK.

 

•

 

Select a set, select [New Set], or click outside any 
set in the Destination list on the left. Then click 
Add. If you selected [New Set], type a name and 
click OK.

 

If you choose Add from Font Sets from the 
Source list, you can drag one or more sets and 

drop them on a set in the Destination list. All the 
fonts in the dragged sets will be added to the set in the 
Destination list.

 

Searching for fonts

 

If you normally keep your font files in a number of 
different folders on your hard disk or you want to 
install fonts from multiple folders on a CD or 
network, use the Search command to simplify the 
process of adding fonts.
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The Search command tells ATM Deluxe to look for 
fonts that are not installed on your system, to 
create a set named Search Results if it does not 
exist, and to add the fonts to this set. After that, 
you can copy the fonts to any set you want. ATM 
Deluxe skips any fonts that are already added to 
your system. If the Search command finds 
duplicate font files that have not been installed, 
only the first one found will be added. 

 

To search for and add uninstalled fonts:

 

1

 

In ATM Deluxe, click the Add Fonts tab. 

 

2

 

If you already have an active set named Search 
Results, either rename it or deactivate it. ATM 
Deluxe cannot search for fonts with the Search 
Results set active. For more information, see 
“Activating and deactivating fonts and sets” on 
page 8 and “Renaming a set” on page 12.

 

3

 

Choose File > Search.

 

4

 

Click Browse to specify a disk drive or folder 
from which to start the search. ATM Deluxe will 
look for fonts in all folders within the starting 
place you designate. You can only search one disk 
at a time.

 

5

 

During a search, ATM Deluxe defaults to adding 
fonts without copying any font files to your hard 
disk. However, if you want ATM Deluxe to copy 
the files it finds to your target font folders, deselect 
this option. For more information about target 
folders, see “Changing the location for new fonts” 
on page 19.

 

6

 

Click Begin Search.

 

7

 

Click OK to confirm the number of fonts, if any, 
that the Search command found and added. To 
begin a new search (on another drive, for 
example), go back to step 4. 

 

8

 

Rename the Search Results set, or copy the 
newly found fonts into other sets and then delete 
the empty Search Results set. For additional infor-
mation, see “Adding fonts” on page 5 and 
“Renaming a set” on page 12.

 

Removing fonts

 

You may want to remove a font you no longer use. 
You can remove the font files completely from 
your hard disk or just remove the font from one set 
or all sets, leaving the font files on your hard disk. 
If you remove a font’s files from your hard disk and 
later need that font again, you must reinstall it 
from the original disk.

 

To remove a font:

 

1

 

In ATM Deluxe, click the Sets tab or the Add 
Fonts tab.

 

2

 

Select the fonts you want to remove. If you are 
using the Add Fonts tab, select fonts in the Desti-
nation list.

 

3

 

Click the Remove button. You can also right-
click a font or a selection of fonts and choose 
Remove.

 

4

 

For each font in your selection, ATM Deluxe 
prompts you with a number of options:
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•

 

To remove the font from every set and from the 
font list, select Remove Fonts from All Sets and 
Master Font List. To remove the font from the 
current set only, leave this option deselected.

 

•

 

To delete font files, select Remove Font Files 
from Disk. To use this option, you must first select 
the previous option.

 

•

 

If you are not certain whether the font is on your 
hard disk or a network drive, click Properties to 
verify the location of the files that will be removed. 

 

Note: 

 

If you are about to remove files from a network 
drive and other people may be using them, click 
Cancel to close the Properties dialog box and make 
sure Remove Font Files from Disk is deselected.

 

5

 

Choose one of the following options:

 

•

 

Click Yes to confirm removal of the font named 
in the dialog box.

 

•

 

Click Skip to leave the font installed and go to 
the next selected font.

 

•

 

If you don’t need to check the properties of each 
font, click Yes To All to remove all selected fonts.

 

Activating and deactivating 
fonts and sets
The ability to activate or deactivate fonts and sets 
lets you simplify font menus and speed up your 
system. Because inactive fonts do not appear on 
the font menus of your applications or take up any 
system resources, you can improve system perfor-
mance by activating only the fonts you need. 
Selective activation also helps you ensure that the 
fonts you need are available, even in applications 
that limit the number of fonts listed in font menus.

You can activate and deactivate an entire set or 
individual fonts within a set. If a font exists in 
more than one set, it will appear in the font menus 
of your applications any time it is activated in at 
least one set.

Note: When you use ATM Deluxe to activate or 
deactivate fonts while other applications are 
running, the changes usually appear immediately in 
the application font menus. However, some applica-
tions show changes in font menus only after you 
restart the applications or reselect your printer.

Because each multiple master font instance uses its 
corresponding base font, ATM Deluxe makes sure 
the base font is in the same set (or outside any set) 
and has the same active or inactive status as the 
instance. For example, if you deactivate a multiple 
master base font outside any set, instances of that 
font in the same location will become inactive 
as well. And if you activate a multiple master 
instance that is outside any set, its base font will 
become active as well (if it isn’t already). For 
more information on multiple master fonts, see 
Chapter 2, “Using Multiple Master Fonts.”
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To activate or deactivate a font or a set:

1 In ATM Deluxe, click the Sets tab.

2 Select the check box of any set or font you want 
to activate. Deselect a check box to deactivate a set 
or font. A gray check box indicates a set in which 
at least one font is inactive. 

You can also use this method in the Add Fonts 
tab. Either use the Destination list or choose 

Add from Font Sets from the Source list.

Deactivating TrueType fonts in the 
Windows\Fonts folder

ATM Deluxe cannot deactivate True Type fonts 
located in the Windows\Fonts folder. Before you 
can deactivate these fonts, you must move their 
font files to the default TrueType folder used by 
ATM Deluxe: Windows\Fonts\ATMFolder.

Important: In Windows 95, Windows 98, or later, 
don’t move the following fonts from the 
Windows\Fonts folder: Courier 10, 12, 15; Modern; 
MS Sans Serif 8, 10, 12, 14, 18, 24; MS Serif 8, 10, 
12, 14, 18, 14; Small Fonts; and Symbol 8, 10, 12, 14, 
18, 24. Also, don’t remove any hidden system font 
files, such as Dosapp.fon, Martlett.ttf, and 
Vgafix.fon. These hidden files don’t appear in 
Windows Explorer or the Fonts Control Panel, but 
may appear in font management utilities.

To deactivate TrueType fonts in the Windows\Fonts 
folder:

1 In ATM Deluxe, click the Settings tab.

2 Make sure the target folder for TrueType files is 
Windows\Fonts\ATMFolder.

3 Click the Add Fonts tab, and add the TrueType 
fonts again (see “Adding fonts” on page 5). Do not 
select the Add Without Copying Files option.

4 When prompted to specify duplicate font file 
locations, select Use New for All.

5 Click the Font list tab and make sure the fonts 
you added are inactive. If the fonts are active, click 
the Sets or Add Fonts tab and then deactivate the 
fonts (see the preceding procedure).

6 In Windows, choose Start > Settings > Control 
Panel, and then double-click Fonts.

7 Remove from the Fonts folder the TrueType 
fonts you have just added in steps 3 and 4.

Activating a font from the Font List tab

If you want to activate an inactive font and you 
don’t know what set or sets it is in, you can activate 
it from the Font List tab. This procedure makes a 
copy of the font outside any set.

To activate a font from the Font List tab:

1 In ATM Deluxe, click the Font List tab.

2 Select the font or fonts you want to activate.
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3 Right-click a font or one font in a selection and 
choose Activate Font(s) Outside Any Set.

You can also use this method in the Add Fonts 
tab. Choose Add from Master Font List from the 

Source list. Then right-click a font in the Source list 
to activate a font as described in the steps above.

Managing sets
ATM Deluxe lets you export, import, and rename 
sets as well as print a list of fonts in a set.

Exporting sets

Once you’ve created sets, you can export these sets 
for use on other computers that run ATM Deluxe, 
including Mac OS systems. Exporting a set does 
not copy fonts for moving to other computers, but 
it simplifies creating sets on other computers that 
have the same fonts as those sets.

If you use the export feature with multiple sets 
selected, ATM Deluxe combines those sets into a 
single export file. However, upon importing them, 
ATM Deluxe displays each set in the export file 
separately. This lets you selectively import one or 
more sets from the export file. If you want to 
export each set as a separate export file, repeat the 
following procedure for each set.

The names of exported sets are stored in the 
export file and are not affected by renaming the 
export file.

Exporting sets is a good way to store a backup of 
your font sets. If your sets are ever deleted 

accidentally, you can restore them by importing the 
exported sets.

To export a set:

1 In ATM Deluxe, click the Sets tab.

2 Select one or more sets you want to export. 

Note: If you select individual fonts in a set or fonts 
outside any set (which can’t be exported), ATM 
Deluxe does not include these fonts in the export file.

3 Do one of the following:

• Choose File > Export Set.
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• Right-click a set or one set in a selection and 
choose Export Set.

4 Locate the folder in which to store the export 
file, type a name for the file, and click Save.

You can also use this method in the Add Fonts 
tab. Right-click a selection in either the Desti-

nation list or the Source list after choosing Add from 
Font Sets from the Source list.

Importing sets

When importing sets, you can add the imported 
sets as new, separate sets, or you can combine 
the fonts in the imported sets into a new or 
existing set.

To import a set:

1 In ATM Deluxe, click the Add Fonts tab. 

2 Choose Browse for Fonts from the Source list 
and locate the export file. If the file contains more 
than one set, you will see multiple sets in the 
Source list.

3 Select one or more sets and do one of the 
following:

• Drag and drop one or more imported sets onto 
an empty part of the list to add each imported set 
as a separate new set.

• Drag and drop two or more imported sets onto 
[New Set] to combine them into a single new set.

• Drag and drop imported sets onto an existing set 
to add all the fonts from the imported sets to the 
existing set.

4 If ATM Deluxe cannot locate matching fonts on 
the destination system, ATM Deluxe prompts you. 
Locate the missing font files or click Skip. 



CHAPTER 112
Managing Fonts

5 If you import a set that has the same name as an 
existing set, ATM Deluxe asks whether to add the 
fonts in the imported set to the set of the same 
name. If that’s not what you want, click Cancel, 
rename the existing set, and then import the set 
again. See “Renaming a set” on page 12.

Renaming a set

Although you name a set at the time you create it, 
you can change it at any time.

To rename a set:

1 In ATM Deluxe, click the Sets tab.

2 Right-click a set and choose Rename.

3 Change the set name and click OK.

You can also use this method in the Add Fonts 
tab. Either use the Destination list or choose 

Add from Font Sets from the Source list. In the Desti-
nation list, you can either right-click or choose Set > 
Rename.

Printing a set index

If you want a paper record showing all the fonts in 
a given set, you can print a set index. The index 
lists the name of each font. Below each name is a 
sample of the font that shows as many letters of the 
alphabet and numerals 0 through 9 as will fit on a 
single line in 14-point type. The name of the set 
appears at the top of each page with page numbers 
at the bottom.

A set index gives you a paper record of all the fonts in a set 
complete with type samples.

To print a set index:

1 In ATM Deluxe, click the Sets tab.

2 Right-click a set and choose Print > Set Index.

3 If necessary, adjust settings for your printer and 
click OK.

You can also use this method in the Add Fonts 
tab. Either use the Destination list or choose 

Add from Font Sets from the Source list.
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Chapter 2: Using Multiple Master 
Fonts

ou can use multiple master fonts as you 
would any other PostScript Type 1 font. 
The main difference is that multiple 

master fonts let you create your own variations on 
the base design.

About multiple master 
font designs
Each multiple master font consists of two parts: 
the multiple master font itself (called the base font) 
and one or more instances of the font. An instance 
is a particular rendition of the font that varies from 
other instances in one or more attributes such as 
weight or width. Because the base font stores 
information required for printing, ATM Deluxe 
automatically copies the base font to any set to 
which you add an instance.

Each multiple master font provides a collection of 
ready-to-use primary instances that constitute a 
complete typeface family. The typeface designer or 
manufacturer determines the selection of primary 
instances. One of the primary instances is desig-
nated the default instance. The default instance is 
the instance displayed when you select a multiple 
master base font.

Each multiple master includes one or more design 
axes. A design axis is a variable typeface attribute, 
such as weight, width, style, or optical size. 

To find out which design axes are included with a 
given multiple master font, see your multiple 
master font package. If you have already installed 
the multiple master font, you can see the design 
axes available for that typeface in ATM Deluxe. For 
information about modifying multiple master 
fonts, see “Creating custom instances” on page 14.

You can vary attributes within the range of each 
design axis.

Multiple master instances are named in the format 
Family_design coordinates, where Family is the 
name of the typeface and design coordinates 
identifies a particular instance by a string of 
numbers and letters (for example, VivaMM_385 
RG 400 CN).

Y

Weight

Width

Style

Optical size

Light Black

Condensed extra-extended

sans serif serif

6 point 72-point (scaled to same size)
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The design coordinates consist of alphanumeric 
combinations for each design axis in the font. If 
the font has a single design axis, there is a single 
alphanumeric combination (for example, 385 RG 
for regular weight). If there are two design axes, 
there will be two alphanumeric combinations, 
and so on. 

Instance names, like VivaMM_250 LT 1500 XE (left) 
and VivaMM_385 RG 400 CN (right), indicate each 
font’s design attributes.

Within the design coordinate name, the numbers 
indicate the position of the instance along the 
design axis. The letters indicate style (regular, 
bold, condensed) for a primary instance, or the 
design axis (weight, width, optical size) for a 
custom instance.

The labels for primary instances included in a 
multiple master font package use uppercase abbre-
viations (XL for extra-light), while custom 
instances use generic lowercase abbreviations (wt 
for weight and wd for width). 

Note: Some font menus and lists in Windows appli-
cations are limited in width. Longer instance names 
may appear clipped.

Creating custom instances
You create custom instances of an installed multiple 
master font by selecting positions along each of the 
design axes in the multiple master font, adding the 
instance to a font set on your system, and 
activating it. After that, the custom instance name 
appears in ATM Deluxe and in your applications’ 
font menus and lists.

To install one of the primary instances that comes 
with a multiple master font, add it as you would 
any other font from its installation disk. See 
“Adding fonts” on page 5. You can also use the 
Primaries button as explained below. 

To create a custom instance:

1 In ATM Deluxe, click the Add Fonts tab.

2 From the Source list, choose Create Multiple 
Masters.

3 From the Multiple Master Base Font list, choose 
the multiple master font you want to work with.

4 If you want to start from one of the base font’s 
primary instances, click Primaries. Make sure 
Show Primary Instances is selected, and then click 
Close.

5 If desired, adjust the size of the sample text by 
dragging the slider to the right of the sample. This 
only affects the sample display, not the instance 
itself. 

You can edit the text by right-clicking in the 
sample and choosing Edit Sample Text. Type a 

new sample and press Enter.
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6 Adjust the design axes values for the instance by 
dragging the sliders or by entering a new value in 
the numeric field. Each design axis has its own 
slider.

7 Select Bold, Italic, or both. Not all styles are 
available for all multiple master fonts. View the 
results in the Sample box.

8 Compare different effects side by side by 
clicking New Window and adjusting different 
settings. You can open up to five Create Multiple 
Masters windows. Drag the Create Multiple 
Masters window to one side so you can compare 
the samples. To designate a destination set in the 
new window, select it from the list at the bottom of 
the window. 

When you are satisfied with the design, drag the 
sample or the instance name under the sliders and 
drop the instance on a set, on [New Set], or outside 
any set in the Destination list. For a new set, type a 
name and click OK. If the destination to which you 
add an instance does not contain the multiple 
master base font, ATM Deluxe automatically adds 
the base font for you. 

You can also select a destination in the Desti-
nation list and click Add to generate the new 

instance as you have specified it, or click Add All 
Styles to generate all available styles for the custom 
instance, such as bold, italic, or bold italic.

Removing multiple master fonts 
and instances
To remove custom instances you no longer need, 
just remove them as you would any other Type 1 
font. Follow the steps in “Removing fonts” on 
page 7.

Important: If you remove a multiple master base 
font from a set, ATM Deluxe also removes all of its 
primary and custom instances.

Using custom instances you 
have not created (Windows 95, 
98, or later)
In Windows 95, Windows 98, or later, you can 
open documents that use instances you may not 
have created on your system. As long as you have 
the correct multiple master base font installed, 
ATM Deluxe renders these fonts as needed—on 
the fly—for the individual document.

Applications vary in the way they handle these on-
the-fly instances. Some place the instance name in 
the application font menu, some display and print 
the instance correctly but do not place it in the font 
menu, and some alert you to the presence of the 
instance in a document so that you can create it 
yourself.
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s your font collection grows, so does your 
need to organize fonts into sets and have 
access to information about these fonts. 

Adobe Type Manager Deluxe not only lets you 
print font samples and font lists but also provides 
some statistical information about the sets and 
fonts you have.

Turning ATM Deluxe on and off
By default ATM Deluxe is turned on upon instal-
lation. However, you can turn it off at any time. 
For example, you might turn ATM Deluxe off 
when trying to troubleshoot a system problem. 
Even when ATM Deluxe is off, you can still use it 
to manage TrueType fonts.

Note: In Windows 2000 Professional, you can’t turn 
ATM Deluxe off.

To turn ATM Deluxe on and off:

1 In ATM Deluxe, click the Settings tab.

2 For ATM System, click On or Off.

3 Click the close box to close ATM Deluxe, and 
then click OK to acknowledge the prompt to 
restart Windows. You can restart Windows 
immediately and see the changes or wait to see 
your changes the next time you start Windows.

Viewing font information
ATM Deluxe keeps track of the number of fonts 
that are active and can show you these totals for 
each font type: Type 1, Type 1 multiple master base 
font, multiple master instance, and TrueType. The 
Font Totals dialog box also shows the number of 
active sets. For information on sets, see “About 
sets” on page 3.

In addition to font totals, ATM Deluxe can show 
you a list of every instance that has been added to 
your system for a particular multiple master base 
font. You can use this list to select an installed 
instance, and, if desired, modify it to add a new 
instance.

To view font totals:

1 In ATM Deluxe, click the Sets tab or click the 
Font List tab.

2 Choose Display > Show Font Totals.

A
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To see what instances have been added for a multiple 
master base font:

1 In ATM Deluxe, click the Add Fonts tab. 

2 From the Source list, choose Create Multiple 
Masters.

3 From the Multiple Master Base Font list, choose 
a multiple master base font.

4 Click Primaries.

5 Select Show Installed Instances.

6 If you want to modify one of the instances, 
select it and click Select, or double-click the 
instance name. Then either drag the window aside 
or click Close to modify the instance in ATM 
Deluxe. For more information, see “Creating 
custom instances” on page 14.

Customizing the information 
ATM Deluxe displays
If you want to see at a glance what fonts are active 
on your system, you can hide inactive fonts and 
sets on lists in the Sets and Font List tabs in ATM 
Deluxe.

To change the display for the Font List tab:

1 In ATM Deluxe, click the Font List tab.

2 Click Only Active Fonts to display only fonts 
that are active. Click All Installed Fonts to display 
all fonts.

To change the display for the Sets tab:

1 In ATM Deluxe, click the Sets tab.

2 Choose Display > Display Active Fonts to see 
only sets that have at least one active font, as well 
as active fonts outside any set. Choose Display > 
Display Font Sets to display all font sets and fonts 
outside any set.

Customizing and printing sample 
sheets
Previewing fonts on-screen can help you decide 
whether a font is appropriate for your current job 
or for a set you’re creating. But you may find it 
faster to keep and refer to a collection of printed 
samples. Printed copies can also be given to others 
who get printed output from your system. The 
printed sample sheet has the same information as 
the on-screen version.
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You can customize the sample text you see on-
screen and in printed sample sheets. For infor-
mation on previewing fonts on-screen, see 
“Previewing fonts” on page 4.

To change the sample text:

1 In ATM Deluxe, click the Settings tab.

2 Click Advanced. For Sample Text, modify the 
text in the Sample Sheets box. Then click OK. The 
change takes effect the next time you display or 
print a sample sheet.

Advanced Settings dialog box for Windows 95, Windows 98, 
or later

Advanced Settings dialog box for Windows NT or Windows 
2000 Professional

To print a sample sheet:

1 In ATM Deluxe, click any tab that shows 
individual fonts. 

2 Select one or more fonts or sets (except fonts in 
an export set) for which you want to print sample 
sheets.

3 Right-click a selected font and choose Print > 
Sample Sheets. 

4 If necessary, adjust settings for your printer. 
Then click OK.

You can also print a sample sheet from the 
sample sheet window. Open a sample sheet 

window as described in “Previewing fonts” on 
page 4. Then choose Sample > Print, adjust printer 
settings as needed, and click OK. This is the way 
to print a sample sheet for a font you have not added 
to your system.

Changing the location for 
new fonts
When you add a font to your system, you can 
designate whether ATM Deluxe copies the font 
files to your hard disk or leaves them on their 
source disk (see “Adding fonts” on page 5). When 
you first installed ATM Deluxe, you chose a default 
location for copying font files. You can change that 
location at any time using ATM Deluxe. You can 
also set a location for TrueType font files.

Note: If you change the location and then add a font 
already on your system, ATM Deluxe will detect the 
duplicate and will ask you which copy to use.
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To set a location for font files:

1 In ATM Deluxe, click the Settings tab.

2 Under Target Folders for New Fonts, type a 
folder path for PostScript font outline files, 
PostScript font metrics files, and TrueType font 
files in the spaces provided. To locate an existing 
folder, click the appropriate Browse button, locate 
and open the folder, and click Select.

Smoothing on-screen fonts
You can use ATM Deluxe to apply anti-aliasing—a 
technique for blending colors along an edge to 
provide a smoother, softer edge to your Type 1 
fonts on-screen.

Smoothing off and smoothing on

To smooth PostScript fonts (Windows 95, Windows 98, 
or later):

1 In ATM Deluxe, click the Settings tab, and then 
click Advanced.

2 Select Smooth Font Edges on Screen and 
click OK.

Note: Anti-aliasing can slow down type-intensive 
displays on some systems. You can speed the display 
of type by increasing the ATM Deluxe font cache; see 
“Adjusting the ATM Deluxe cache (Windows 95, 98, 
or later)” on page 22.

To smooth PostScript and TrueType screen fonts 
(Windows NT or Windows 2000 Professional):

1 In Windows, choose Start > Settings > Control 
Panel.

2 Double-click the Display icon.

3 Click the Plus! tab (Windows NT) or the Effects 
tab (Windows 2000 Professional).

4 Make sure Smooth Edges of Screen Fonts is 
selected, and then click OK.

Customizing font handling
ATM Deluxe can manage fonts even if they were 
installed without using ATM Deluxe. It also lets 
you decide how to handle inactive multiple master 
instance files. In Windows 95, Windows 98, or 
later, ATM Deluxe can provide substitutes for 
missing fonts and specify what kind of font infor-
mation is sent to your printer or screen.

To customize font handling settings:

1 In ATM Deluxe, click the Settings tab.

2 Click Advanced.

3 Select or deselect the following options and 
click OK.

Check for New or Removed Type 1 Fonts When Start-
ing ATM Deluxe. Tells ATM Deluxe to manage 
PostScript fonts installed or removed by a 
program other than ATM Deluxe. When this 
option is selected, the next time you start ATM 
Deluxe, it adds PostScript fonts installed by 
another program as active fonts outside any set.
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Check for New or Removed TrueType Fonts When 
Starting ATM Deluxe. Tells ATM Deluxe to manage 
TrueType fonts installed or removed by a program 
other than ATM Deluxe. When this option is 
selected, the next time you start ATM Deluxe, it 
adds TrueType fonts installed by another program 
as active fonts outside any set. It also removes any 
fonts removed by another program.

Delete Inactive Multiple Master Instance Files.
Deletes instances when they are inactive and re-
creates them later when you activate the font. The 
instance name is still visible in all ATM Deluxe 
lists, but if you right-click a font and choose 
Properties, ATM Deluxe reports that the files are 
missing. Deselecting this option speeds up font 
and set activation and deactivation but takes up 
more hard disk space.

Smooth Font Edges on Screen (Windows 95, 
Windows 98, or later). Smooths the edges of fonts 
for on-screen display. 

Print Fonts as Graphics (Windows 95, Windows 98, 
or later). Sends fonts to the printer as graphic 
images rather than downloading the font file itself. 
This setting may help older PCL printers that 
cannot use downloadable fonts or when printing 
documents with mixed text and graphics that 
don’t print correctly. Printing time may increase.

Display Fonts as Graphics (Windows 95, Windows 98, 
or later). Sends fonts to your monitor as graphic 
images instead of generating screen fonts from the 
font files. Use this setting only if you are having 
difficulty with on-screen font displays. Screen 
redraw time may increase slightly.

Use Pre-Built or Resident Fonts (Windows 95, 
Windows 98, or later). Uses bitmap fonts installed 
in Windows for screen fonts and bitmap fonts 
resident in the printer for printing. Bitmap fonts 
take up hard disk space but can help certain appli-
cations display and print documents more quickly.

Enable Auto-Activation (Windows 95, Windows 98, 
or later). Automatically activates an installed but 
inactive font any time you open a document that 
uses that font in certain applications. (See the 
ATM Deluxe Read Me file for application compat-
ibility.) With auto-activation enabled, your 
otherwise inactive font will display and print 
properly but won’t appear in your applications’ 
font menus and lists.

Enable Font Substitution (Windows 95, Windows 98, 
or later). Simulates the shape and spacing of a 
font not installed on your system when you 
open a document using that font in certain appli-
cations. (See the ATM Deluxe Read Me file for 
application compatibility.) Substitution also 
occurs for installed but inactive fonts if Enable 
Auto-Activation is deselected. The substituted font 
may not match the missing font but will preserve 
your line breaks and general document 
appearance until you can obtain the proper font.

Note: The intent of font substitution is to provide 
placeholders for the original typefaces while a work 
is in progress. Final documents should be produced 
and printed using the original typefaces.
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Adjusting the ATM Deluxe cache 
(Windows 95, 98, or later)
ATM Deluxe uses a cache—a portion of system 
memory used to store font data created by ATM 
Deluxe. A large cache may speed up scrolling and 
other screen displays of fonts but can limit the 
amount of memory available to other applica-
tions. The default cache size is 512K. If you are 
using ATM Deluxe for Windows 95, Windows 98, 
or later, and you typically use many different fonts 
on a single page, you may want to experiment with 
a larger cache size.

To adjust the ATM Deluxe cache size:

1 In ATM Deluxe, click the Settings tab.

2 Click the up or down arrows next to ATM Font 
Cache to change the amount of memory reserved 
for the cache.

Click the close box to close ATM Deluxe. When 
prompted, click Restart to restart Windows 
immediately and see the changes, or click 
Continue to see your changes the next time you 
start Windows.
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dobe Type Manager Deluxe lets you 
control how fonts are sent from your 
system to the printer. If you want to print 

your documents on a system other than the one 
on which they were composed, you may have to 
take some additional steps in your application 
to ensure your document is printed with the 
correct fonts.

Printing files on other computers
To print a document on another computer, you 
have two choices:

• Create a print file or print-to-disk file, which is a 
file created when an application sends printing 
information for a document to a file instead of to 
a printer.

• Ensure that both computers have the same fonts.

Printing to a file

When taking your file to another location for 
output, the new computer does not need to have 
ATM Deluxe or the same fonts installed, providing 
you first create a print file. When printing to a 
non-PostScript printer, this is often as easy as 
selecting Print to File in your Print dialog box.

If the printer you will use is a PostScript printer, 
you need to make a PostScript print file and save 
the necessary fonts with that file. Most applica-
tions that can create a PostScript file also have an 
option for saving the fonts with the file. Consult 
your application documentation for creating 
PostScript print files with the fonts you need.

Once you have a print file, you can take that file 
to another system and use the DOS copy /b 
command to send it to a printer without opening 
it. For more information on copying a file to a 
printer, consult your DOS documentation.

Multiple master issues

If it’s necessary to open a file in an application to 
print it, the system from which you print needs to 
have the same Type 1 fonts as are used in the 
document. In addition, if your document uses 
multiple master fonts, you should make sure that 
the system from which you print has the following 
software installed:

• The same version of the application that you 
used to create the document.

• The multiple master base fonts corresponding 
to the multiple master instances used in the 
document.

• The same custom instances as used in the 
document (Windows NT or Windows 2000 
Professional).

A
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In Windows 95, Windows 98, or later, you may not 
need each custom instance used in a document in 
order to print a document using multiple master 
fonts. Some applications, like Adobe PageMaker® 
and Microsoft Word, can re-create custom 
instances automatically for documents that need 
them; other applications cannot. If in doubt, check 
with the manufacturer; also make sure that you are 
using the latest version of the application. 

If your application can’t re-create custom 
instances on other computers, you must install 
your custom instances on the system from which 
you will print or give those instances to the service 
provider that will print your file. If ATM Deluxe is 
installed on the computer from which the file will 
be printed, you can transfer the information in 
custom instances using the export set feature in 
ATM Deluxe.

Note: While it is legal to give your service provider 
multiple master custom instance files, it is illegal to 
give them multiple master base fonts (or any other 
Type 1 font). Always make sure your service provider 
owns a license for the appropriate multiple master 
base font or any other fonts needed for your job. (See 
the license agreement included with your font.)

To move custom instances to another computer with 
ATM Deluxe:

1 On the first computer, create a set that contains 
the custom instances you want to take to another 
computer. See “Creating sets” on page 5 and 
“Adding fonts” on page 5.

2 Export the set with custom instances. See 
“Exporting sets” on page 10.

3 Copy the exported set to a floppy disk or 
network server and transfer it to the second 
computer.

4 On the second computer, start ATM Deluxe and 
import the set. See “Importing sets” on page 11.

Setting download options for 
the Microsoft PostScript driver 
(Windows 95, 98, or later)
If your system uses the Microsoft PostScript 
printer driver, you can choose where the printer 
driver looks for fonts when you print. This choice 
can affect whether you get the correct font from 
the printer. The option you choose in the Settings 
tab affects all future fonts you add, but you can 
also adjust these options for individual fonts.

In choosing the best option, you need to consider 
the impact on the WIN.INI file, an important 
Windows configuration file. For each PostScript 
font you add to your system, ATM adds a reference 
to the WIN.INI file indicating the location of the 
font metrics file and (if you use the autodown-
loading option) the font outline file. In addition, 
ATM adds one such reference for each printer port 
used by the Microsoft PostScript driver. If you have 
installed multiple PostScript printers on different 
ports (regardless of what is physically connected to 
your computer), ATM adds a reference for each 
port for every active font on your system, causing 
the WIN.INI file to grow in size. 

As the file size approaches 64K (the maximum 
allowable size), you could have unpredictable 
system problems. To keep the WIN.INI file 
smaller, try one or more of these suggestions:
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• Use the Adobe PostScript printer driver, which 
doesn’t use the WIN.INI file. The Adobe 
PostScript driver is available on the ATM Deluxe 
CD and from www.adobe.com.

• Create sets and activate only the sets or fonts you 
need. See “Creating sets” on page 5.

• If you have PostScript printers installed on 
multiple ports that you don’t use, choose Start > 
Settings > Printers and delete the printers you 
don’t use. For more information, refer to Windows 
online help.

• If your printer has fonts installed on its hard disk 
or if you use a font downloading utility to 
download fonts to your printer’s RAM, designate 
those fonts as resident in the PostScript printer 
(see the procedures below).

• Use the “Mark as Not to Be Installed for the 
PostScript Printer” option (see the following 
procedure and note the limitations of this option).

• Shorten the path of your font files by installing 
them to folders such as c:\f and c:\f\pfm. See 
“Changing the location for new fonts” on page 19.

To set font download options when using the 
Microsoft PostScript driver:

1 In ATM Deluxe, click the Settings tab.

2 Click MS PostScript Driver. 

3 For new fonts that you add, select one of the 
options described below and then click OK.

• Select Mark as Autodownload for PostScript 
Printer to send each font to the printer automati-
cally when it is needed. This ensures that the font 
will print correctly each time but creates the 
longest entry in the WIN.INI file.

• Select Mark Fonts as Resident in PostScript 
Printer for fonts that are on your printer’s hard 
disk or that you download to the printer’s RAM. If 
a font is not at the printer, it won’t print correctly. 
This setting creates a shorter entry in the WIN.INI 
file for each font.

• Select Mark as Not to Be Installed for the 
PostScript Printer to have ATM Deluxe send only 
those characters of a font needed for correct 
printing. This setting requires no reference in the 
WIN.INI file but may not produce correct results 
for applications that generate their own PostScript 
code, such as PageMaker and QuarkXPress.

For each font, the settings take effect the next time 
you activate a font.

To modify font download options for an individual 
font when using the Microsoft PostScript driver:

1 In ATM Deluxe, click any tab that shows 
individual fonts.

2 Right-click on any font and choose Properties. 
For Installed as, select an option as explained in 
the previous procedure. Then click OK.
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his section contains solutions to problems 
with installing or using ATM Deluxe. For 
more information, see the ATM Deluxe 

Read Me file included with your software. Use 
any word processor or text editor to open and read 
the file.

Before troubleshooting a display or printing 
problem, verify that you are using the latest 
versions of your video and printer drivers.

Characters appear incorrect on-screen or 
when the document is printed.

Make sure of the following items:

• ATM Deluxe is installed.

• The ATM Deluxe program is turned on in the 
ATM Deluxe Settings tab.

• You are using a PostScript Type 1 font that is 
installed in ATM Deluxe. 

• You restarted Windows after you installed the 
ATM Deluxe program.

• None of your activated TrueType fonts has the 
same name as any of your activated PostScript 
fonts. If you have two fonts with exactly the same 
name, deactivate one of the fonts. See “Activating 
and deactivating fonts and sets” on page 8.

• If the font is a TrueType font you have deacti-
vated in ATM Deluxe, you have moved the font 
from the Windows\Fonts folder (see “Deactivating 
TrueType fonts in the Windows\Fonts folder” on 
page 9).

• Your printer is set for the highest resolution in its 
setup dialog box.

Characters appear incorrect on-screen 
but print properly on a PostScript printer.

For each font that is resident or built into your 
printer, install the corresponding font in ATM 
Deluxe. For more information, see “Adding fonts” 
on page 5.

Fonts don’t appear in the application 
font menu.

Try the following solutions:

• In ATM Deluxe, make sure the fonts have 
been added. A font has been added if its name 
appears in the list in the Fonts List tab. If you don’t 
see the names of your fonts, add the fonts again 
as explained in “Adding fonts” on page 5.

• If the fonts are listed but have no checkmark, 
click Sets and activate the fonts as explained in 
“Activating and deactivating fonts and sets” on 
page 8.

• If the fonts have been added and are active, 
deactivate the fonts and then activate them again. 
See “Activating and deactivating fonts and sets” on 
page 8.

• Restart the application.

• Reselect your printer from within the 
application.

T
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You add several fonts in the same 
typeface family, but you only see a few of 
them in your applications’ font menu.

Make sure the fonts are installed and active. For 
more information, see “Adding fonts” on page 5 
and “Activating and deactivating fonts and sets” 
on page 8. Next, see if the font names have a 
comma in them, indicating a style link—fonts in a 
typeface family that differ only in the style 
attributes bold, italic, and bold italic. Style-linked 
fonts don’t appear in font menus, but all fonts are 
available by applying the application’s bold and 
italic attributes.

Windows can only apply four styles (normal, bold, 
italic, and bold italic). As a result, typeface families 
that have many variations (such as semibold or 
black) may consist of multiple style-linked fonts.

In addition, Type 1 fonts have PostScript names, 
which may not be the same as the names that 
appear in ATM Deluxe, nor in your font menus. 

To see a font’s PostScript name, double-click the 
font to open its sample sheet, or right-click the 

font in ATM Deluxe and choose Properties.

For example, the Adobe Garamond® family has six 
fonts with the following PostScript names:

• AGaramond-Regular

• AGaramond-Semibold

• AGaramond-SemiboldItalic

• AGaramond-Italic

• AGaramond-Bold

• AGaramond-BoldItalic

The corresponding names in ATM Deluxe are:

• AGaramond

• AGaramond, Bold

• AGaramond, Bold Italic

• AGaramond, Italic

• AGaramond Bold

• AGaramond Bold, Italic

Each font name with no comma appears in your 
font menus; the others do not. Consequently, the 
above fonts would appear on your font menus 
only as:

• AGaramond

• AGaramond Bold

To get AGaramond-Semibold, you must apply the 
bold attribute to text using AGaramond (this 
actually uses AGaramond, Bold—the font with a 
comma). To get AGaramond-Bold, you simply 
apply AGaramond Bold (the font with no comma) 
to text.
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A font you deactivated (or a font in a set 
you deactivated) still appears in font lists 
and menus.

The font may be active in another set. If a font is in 
any active set or is active outside of any set, it will 
appear in font lists and menus. To see a list of only 
active fonts, click the Font List tab and choose 
Display > Display Only Active Fonts. To see what 
sets a font is in, locate the font in the Font List 
tab in ATM Deluxe. Then right-click the font and 
choose Properties. For more information on 
activating and deactivating fonts and sets, see 
“Activating and deactivating fonts and sets” on 
page 8.

One or more fonts in ATM Deluxe appear 
with a red x in their check box.

The red x indicates a possible problem with a font. 
Try the following:

• Click the Settings tab and make sure ATM 
Deluxe is turned on in the ATM System box.

• Right-click the font and choose Properties. In 
the Files box, check the location of the font files. If 
the font files are stored on a network  drive or CD, 
you may need to reconnect to the proper network 
drive or insert the CD.

• Deactivate the font and then activate it again. If 
prompted, locate and select the requested font file. 
See “Activating and deactivating fonts and sets” on 
page 8.

• Reinstall the font. See “Adding fonts” on page 5.

• Exit ATM Deluxe and delete the Atmreg.atm file 
containing its internal font database. Then restart 
your system. ATM Deluxe regenerates the file.

• If none of the solutions above remove the red x, 
there may be a problem with the font. For 
example, some TrueType fonts lack font infor-
mation that ATM Deluxe uses when activating 
a font. If you can see the font in your application’s 
font menus, you can still use the font despite 
the red x.

Multiple master custom instances appear 
in one document but are not available to 
other applications.

Some applications, such as Adobe PageMaker and 
Microsoft Word, can create a custom instance as 
needed if the original multiple master font has 
been installed. A document that requires a specific 
custom instance will appear correctly on-screen 
and print correctly even though the specific 
custom instance is not installed. To make a custom 
instance available to your other documents and 
applications, create it using ATM Deluxe, as 
explained in “Creating custom instances” on 
page 14.

The PostScript Driver button is dimmed in 
the Settings tab and the Installed in 
WIN.INI as settings in the font Properties 
dialog box are dimmed (Windows 95, 98, 
or later).

These options are dimmed unless you have added 
a PostScript printer using the Microsoft PostScript 
driver. Other drivers, such as the Adobe PostScript 
driver, don’t need these options.
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The On and Off options are dimmed in the 
Settings tab (Windows NT or Windows 
2000 Professional).

In Windows NT, you must log on as an adminis-
trator in order to use these options. In Windows 
2000 Professional, these options are dimmed 
because you can’t turn off the ATM font driver.

Two installed fonts do not appear in ATM 
Deluxe nor in font menus (Windows NT or 
Windows 2000 Professional).

The fonts AdobeSanMM (whose filenames begin 
with ZX______) and AdobeSerMM (whose 
filenames begin with ZY______) are special 
multiple master fonts used by Adobe Acrobat to 
simulate fonts not embedded in a Portable 
Document Format (PDF) file. You cannot apply 
these fonts in any application or preview them in 
ATM Deluxe.
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Index

A

activating

fonts 8–10

multiple master fonts 8

sets 8

Add from Font Sets option 6, 9

Add from Master Font option 6

Add Without Copying option 6

adding fonts 5–6

Adobe home page 2

anti-aliasing fonts 20

ATM Deluxe

installing 1

new features 1

removing 2

starting 1

troubleshooting problems 27

turning on and off 17

uninstalling 2

ATM Font Cache option 22

B

backing up sets 10

base font 5, 13
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Browse for Fonts option 6, 11
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TrueType Fonts When 
Starting ATM option 21
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Display Font Sets 18

Search 7

Show Font Totals 17

Create Multiple Masters 
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printing documents with 24

troubleshooting 29

D

deactivating

fonts 8–10

multiple master fonts 8

sets 8

default instance 13
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Instance Files option 21

deleting

fonts 7

instances 15, 21

design axis 13

design coordinates 14

Display Active Fonts command 18

Display Font Sets command 18

Display Fonts as Graphics 
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download options, setting 24–25

E

Enable Font Substitution option 21

Export Set command 10

exporting sets 10

F-G

font cache 22

Font Totals dialog box 17

font totals, viewing 17

fonts

activating 8–10

adding 5–6

anti-aliasing 20

bitmap 21

deactivating 8–10

hiding in sets 3

licensing 5

multiple master 13

not appearing in menus 27–28

previewing 4

properties 8

removing 7–8

searching for 6–7

smoothing 20

substituting 21

viewing in sets for 4

H

hiding fonts in sets 3

I-K

importing sets 11–12

installing ATM Deluxe 1
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instances

defined 13

deleting inactive 21

removing 15

viewing 18

L

licensing fonts 5

M

managing sets 10–12

Microsoft PostScript driver 
options 24–25

multiple master fonts 13

activating 8

custom instances 14–15

deactivating 8

design axes 13

in sets 5

naming conventions 13–14

printing issues 23–24

removing 15

viewing instances 17–18

N-O

new features 1

P-Q

Post Script fonts, setting download 
options for 24–25

previewing fonts 4

primary instances 13

print file 23

Print Fonts as Graphics option 21

printing

from another computer 23–24

setting download options 24–25

to PCL printers 21

print-to-disk file 23

properties 8

R

removing

ATM Deluxe 2

fonts 7–8

renaming sets 12

S

sample sheets 18–19

sample text, changing 19

Search command 7

searching for fonts 7

set index 12

Set Index command 12

sets

activating 8

backing up 10

creating 5

deactivating 8

defined 3

exporting 10

hiding fonts 3

importing 11–12

managing 10–12

multiple master fonts 5

renaming 12

viewing fonts in 3

Show Font Totals command 17

Show Installed Instances option 18

Show Primary Instances option 14

Smooth Font Edges on Screen 
option 21

smoothing fonts 20

Source list 6

starting ATM Deluxe 1

substituting fonts 21

supported fonts 1

T

troubleshooting 27–29

U

Uninstall option 2

Use Pre-Built or Resident Fonts 
option 21

V

viewing

font totals 17

fonts in a set 3

instances 18

properties 8

W-Z

WIN.INI file 24–25

Windows platforms for ATM 
Deluxe 1



33

Character Access Chart for Windows
Standard Roman Character Set 

key
cap char

shift
char

key
cap char

shift
char

key
cap char

shift
char

A

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

a

b

c

d

e

f

g

h

i

j

k

l

m

n

o

p

A

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

Q

R

S

T

U

V

W

X

Y

Z

1

2

3

4

5

6

q

r

s

t

u

v

w

x

y

z

1

2

3

4

5

6

Q

R

S

T

U

V

W

X

Y

Z

!

@

#

$

%

^

7

8

9

0

`

-

=

[

]

\

;

'

,

.

/

7

8

9

0

`

-

=

[

]

\

;

'

,

.

/

&

*

(

)

~

_

+

{

}

|

:

"

<

>

?

space 
bar
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128

130

131

132

133

134

135

136

137

138

139

140

145

146

147

148

150

151

152

153

154

155

156

159

161

162

163

164

165

166

To access the characters on this page only, hold down the Alt key and use the
numeric keypad to type a zero followed by the ASCII Character Code.

167

168

169

170

171

172

173

174

175

176

177

178

179

180

181

182

183

184

185

186

187

188

189

190

191

192

193

194

195

196

197

198

199

200

201

202

203

204

205

206

207

208

209

210

211

212

213

214

215

216

217

218

219

220

221

222

223

224

225

226

227

228

229

230

231

232

233

234

235

236

237

238

239

240

241

242

243

244

245

246

247

248

249

250

251

252

253

254

255

char

ascii
char
code char

ascii
char
code char

ascii
char
code char

ascii
char
code
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